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Chapter 1 - Introduction to UC Suite 
 

 

 
1 Introduction 

 
This document describes the operation and functionality of the SV9100 UC Suite 
Softphone. 

 
Note: Images are as example only for indication of a specific feature. Some 
aspects such as Photo images and presence are not supported on the 
Softphone. 
 
In this document UC Suite may be used in place of SP310 and are used 
interchangeably. 

 

2 Overview 
 

UC Client as a Softphone extension. 

Audio frame (Payload) size for Softphone only supports 20ms or 40ms 

according to Codec type: 

¿ G.711 – Program 84-24-01 setting must be 20ms or 40ms. 

¿ G.729 – Program 84-24-07 setting must be 20ms or 40ms. 

¿ G.722 – Program 84-24-32 setting must be 20ms. 

 
Through licensing control, system programming and user selection, the application 

can be tailored to meet the needs of a variety of end users. Additional utilities are 

provided as part of the UC Suite: 
 

 CallTo Configuration – Enables or Disables the ability to dial from a CallTo tag/ 

hyperlink in a web page or MS Office document using the UC Suite. 



 

 

3 Installation Considerations 
 

The UC Suite is installed as a standalone UC Client. 

 

3.1 UC Client 

 
Each PC with the UC Client has its own connection to the SV9100. The UC 

Client communicates to the SV9100 via the LAN on the TCP port defined for 

the 1st-Party CTI connection in Program 10-20-01, although a 1st Party CTI 

license is not required for the UC Client. The 1st-Party CTI connection is 

device 9 in 10-20-01 and the recommended port is 8282. 

 
3.2 Remote Connections 

 
Network Address Translation (NAT) is not supported. Because of this, any UC 

Client must appear to be on the same network as the SV9100 VoIP Interface 

(IPLE). For remote UC Clients, such as a Softphone, this can be achieved 

using a VPN connection to the network where SV9100 resides. 

 
3.3 Firewall and Exceptions 

 
When a firewall is involved in the network between the SV9100 and the UC Clients 

and UC Server. Refer to Table 1-1 Exceptions to Firewall for Ports for exceptions to 

be made in the firewall for ports and Table 1-2 Exceptions to Windows Process for 

windows processes. 
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Table 1-1 Exceptions to Firewall for Ports 
 

 

Desktop Component 
TCP and/or 

UDP 

Port 

Numbers 

 

Related Program 

SIP UDP 5070~5197  

Audio RTP UDP 60000~60254  

Video Control TCP 6000  

Video RTP UDP 61000~61019  

File Transfer TCP 8282~8284  

License TCP 6080  

DataConference Control TCP 62010~32019  

DataConference Video UDP 62010~32019  

Outlook Integration/Highlight Dial/CallToTag/XML API TCP 20864~20865  

TSP Support: UDP/TCP 972-973 UDP and TCP 972~973  

UC Server Client Connection TCP 8888  

3rd Party Call Control TCP 8181 10-20-1 Device 1 – CTI Server 

1st Party Call Control TCP 8282 10-20-1 Device 9 – 1st Party CTI 

File and Print Sharing UDP and TCP 137  

Operation & Maintenance (O&M) TCP and UDP 8010  

Web Client UDP and TCP 8080  

 
 

Table 1-2 Exceptions to Windows Process 
 

Windows Process Firewall Exceptions 

NECPhone.exe 

RPCTIService.exe 

DataMeeting.exe 

RtcSvGM.exe 
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4 System Requirements 
 

The minimum recommended PC requirements and the supported operation systems 
are described in this section. 

 

4.1 Minimum PC Requirements 

 
The minimum recommended PC requirements for running the UC Suite 

Softphone application are as follows: 

¿ PC Class: Pentium 3 

¿ Processor Speed: 1GHz 

¿ RAM: 512MB Minimum, 1GB Recommended 

¿ Display: Super VGA (800 x 600) or higher 

¿ Available Disk Space: 50MB 

¿ CD-ROM Drive 

¿ Network Adapter 

¿ Sound Card 

¿ Video Camera (optional) 

¿ Microphone/Headset/USB Handset (optional) 

¿ Speakers (optional) 

 
4.2 Supported Operating Systems 

 
The UC Suite application is supported on the following operation systems: 

 

¿ Windows 7 Professional SP1 (32- and 64-bit) 

¿ Windows Server 2008 (32- and 64-bit) 

¿ Windows Server 2012 

¿ Windows 2016 

¿ Windows 8 Professional and Enterprise (32- and 64-bit) 

¿ Windows 8.1 Professional and Enterprise (32- and 64-bit) 

¿ Windows 10 Pro and Enterprise (64-bit)* 

 

*Communication Board not supported.     



 

 

 
 

4.3 Virtual Machine Support 

 
UC Server supports the virtual machine environments listed below. This option 

provides a cost-effective alternative to implementing a physical server. 

¿ Environment #1 

Applications: UC Server 1.0 

Host: Windows 2012 Server, running VMWare Workstation 9 

Virtual: Windows 7 (32-bit) 

¿ Environment #2 

Applications: UC Server 1.0 

Host: Windows 2012 Server, running VMWare ESXI 5.1 

Virtual: Windows 7 (32-bit) 

¿ Environment #3 

Applications: UC Server 1.0 

Host: Windows Server 2008 R2 Enterprise, running Hyper-V 6.1 

Virtual: Windows 7 (32-bit and 64-bit) 

 
4.4 Licensing 

 
The following table lists and describes the UC Suite Softphone related part numbers: 

 

Table 1-3 UC Suite Licenses 
 

Product code Items Description 

BE114058 SV9100 SOFTPHONE-01 
LIC 

NEC SV9100 Softphone License per client 

BE114497 SV9100 IP PHONE DT-01 
LIC 

DT800/700 IP license per client 

BE114063 SV9100 INMAIL INT-01 LIC InMail integration license per client 

BE108337 UTR-1W-1(BK) USB Handset allowing tradition telephone feel 



 

 

 

 

Chapter 2 - Installation 
 

 

 
Any previous SV8100 Desktop Suite software must be completely uninstalled before 

installing the SV9100 UC Suite. 

 
The installation of the SV9100 UC Suite includes prerequisite software if the 

installation determines these do not already exist on the PC 

 
The following prerequisite software is installed: 
 

 Microsoft .NET Framework 3.5 

 Microsoft Visual C++ 2005 SP1 Redistributable Package 

 
After the prerequisite software is installed, the UC Suite Client installs. This 

installation includes the following applications: 

 SV9100 UC Suite Client 

 Video Test Tool 

 
The UC Suite is installed in the following directory: 

 C:\Program Files\NEC\NEC UC Suite 

 
Application logs are in the following directory: 

 c:\Program Data\NEC-i\PC Phone\logfiles 

 
After installation is complete, the following application environment is available, 

depending on what installation options where chosen: 

 Program group named “NEC” 

 Within NEC group are the following: 

¿ UC Suite 

¿ Video Test Tool 

 

 A shortcut for UC Suite installs on the Windows desktop. 
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1 Installation 

 
1.1 Uninstall Previous Server 

 
Any previous SV8100 versions must be uninstalled manually to ensure the 

complete removal of the application. 
 

 During the uninstall of some components a prompt will  appear asking if the data files 

are to be removed. Choose Yes to remove the data files as part of this upgrade 

procedure. 

 
1. From the Windows Start menu, select Control Panel. 

 

2. Double-click Add or Remove Programs. 
 

3. From the program list, select NEC Desktop Shared Services and 

click Remove. 

4. When the following screen is displayed, select Yes. 
 

 

 
5. When the following screen is displayed, select Yes. 

 

 

 
6. From the program list, select NEC Infrontia Telephony 

Driver(3rd) and click Remove. 

7. Follow the prompts to complete the uninstall of this item. 
 

8. Reboot the blade. (If directly connected with a keyboard, monitor, 

and mouse, choose Start>Shutdown>Restart. If connected with 

Remote Desktop, press Ctl+Alt+End and choose 

Shutdown>Restart.) 
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1.2 Uninstall Previous Client 

 
Any previous SV8100 version must be uninstalled manually to ensure the 

complete removal of the application before the SV9100 UC Suite is installed. 
 

 During the uninstall of some components a prompt will  appear asking if the data files 

are to be removed. Choose Yes to remove the data files as part of this upgrade 

procedure. 

 
1. Verify MS Outlook is not running. 

 
2. From the Windows Start menu, select Control Panel. 

 
3. Double-click Add or Remove Programs. 

 
4. From the program list, select NEC UC Desktop Suite and click 

Remove.  

 
5. When prompted to remove the middleware, select Yes to remove the 

middleware. 

 

 

 

6. When prompted to “remove all of the associated data files”, select Yes to 

remove the data files. 
 

 
 

 

7. When complete, the display returns to the Program list. Close. 
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1.3 Install the UC Client 
 

Ensure .NET 3.5 is installed before installation of the UC Client. 

 
1. Double Click the SetupDesktop.exe. If a Security Warning pops up, 

click Run. 

 
2. When the License Agreement screen appears, click Yes. 

 

 
 

3. The install begins copying files. 
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4. At the NEC UC Suite Welcome window, click Next. 

 

 

 
5. Define the installation folder or click Next to accept the default folder. 
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6. In the Confirm Installation window, click Next. 

 

 
 

7. In the Enable "CallTo" tag window, click Yes. 
 

 
 

8. Click OK in the window indicating Internet Call has been normally 

configured. 

 
9. In the Installation Complete window, click Close. 
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2  SV9100 UCSuite Programming 
 

The following table lists the SV9100 System programming related to the UC Desktop 

Applications. 

 
Programming can be performed via Easy Edit or System Commands, both will be 

shown. 
 
Before performing any program, please run the Script   SP310_Setup_V1.pcs to set 

the basic necessary values for the SP310 to run. 
 

This is performed by first taking a download of the system, then from the Home 
Toolbar selecting run Script: 
 

 
 
 

Then clicking on the folder icon at the side of the script file selection box, to open 
the dialog box asking for the script. Select SP310_Setup_V1.pcs and click open. 
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Click Run. After a few seconds it will say complete. Click the X in the right hand 

corner. You are now ready to start programming. 
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2.1 Easy Edit Programming 
 

The easiest way to program is using the Easy Edit pages after having run the script. 
 
The SP310 items can be found in the first level of Easy Edit under Applications. 
 

 
 

SP310 IP Settings should be set to connect to the network the SV9100 is on, the 1st Party CTI, O&M 
Server and Presence settings should already be set by the Script. 
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SP310 IP Settings should be set to connect to the network the SV9100, it is not usually required to 
change the default RTP port. 
 

 
 
SP310 Basic Settings allows you to set the Extension name and also any login details if IP logon is set 
to Auto or Manual for the SV9100. 
 

 
 

  



 

23  

SP310 Credentials splits into two aspects, the first being User Information. It is recommended you 
enter the extension number and the password that is entered in the SP310 Logon Window (if none 
entered then you can use any password). 
 

 
 

For User Settings. You must enter the same number and the password that is entered in the SP310 
User Information area. All other items can be left as they are (as these are set correctly by the 
script) 
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If using Auto or Manual logon, you will need to enter a User Id and password, the user ID should be 
the extension number. 

 

 
 
 
SP310 Information sets the IP Settings for the IP extension aspects of the SP310, these should not 
need to be altered unless instructed to do so. 
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The SP310 Service Codes section splits in to 3 aspects, it should not be necessary to make changes 
to these areas. 
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2.2 Programming Commands 
 

Two programming CMD’s are required to setup the Softphone user.  
20-57 and 20-59. 

 

For CMD 20-57, on items 01 and 02 are required, please enter a user name and 
password. This will be required when opening the softphone application. All other 
items can be ignored. 

 

 
 

CMD/Item Description Value Default 

20-59-01 UC Server Settings – UC User ID 

Define the user ID for the UC Suite User.  

This must be the same as the Value in CMD 20-59-01 

Any character No Setting 

20-59-02 UC Server Settings – UC User Password 

Define the password for the UC Suite User. 

  This must be the same as the Value in CMD 20-59-02 

Any character No Setting 
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CMD 20-59 has several options to choose from: 
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CMD/Item Description Value Default 

20-59-01 UC Server Settings – UC User ID 

Define the user ID for the UC Suite Usert 

This must be the same as the Value in CMD 20-57-01 

Any character No Setting 

20-59-02 UC Server Settings – UC User Password 

Define the password for the UC Suite User. 

This must be the same as the Value in CMD 20-57-02 

Any character No Setting 

20-59-03 UC Server Settings – UC - DT Client 

Enable or Disable the users ability to launch a UC full PC client. 

This item should be set to Enable 

0 = Disable 

1 = Enable 

0 

20-59-04 UC Server Settings – UC - DT Web Client 

Enable or Disable the users ability to launch a Web Client. 

This item should be set to Disable 

0 = Disable 

1 = Enable 

0 

20-59-05 UC Server Settings – UC - Deskset Extension 

If the UC Suite User will control a Deskset extension, define the 

extension number to control 

This item should be left blank. 

0 ~ 9, , # No Setting 

20-59-06 UC Server Settings – UC - Softphone Extension 

If the UC Suite User will use a Softphone, define the extension 

number. 

Enter the extension number you wish the softphone to be 

0 ~ 9, , # No Setting 

20-59-07 UC Server Settings – UC - IM- Allow 

If the UC Suite User will be allowed to send and receive Instant 

Messages. 

This item is not relevant to Softphone. Leave as Default: 

Disabled 

0 = Disable 

1 = Enable 

0 

20-59-08 UC Server Settings – UC - Shared Data Allow 

Enable if the UC Suite User will be allowed to edit the Directory. 

This item is not relevant to Softphone. Leave as Default: 

Disabled 

0 = Disable 

1 = Enable 

0 

20-59-09 UC Server Settings – UC - Global Presence Change Allow 

Enable if the UC Suite User will be allowed to change other users 

presence states. 

This item is not relevant to Softphone. Leave as Default: 

Disabled 

0 = Disable 

1 = Enable 

0 

20-59-10 UC Server Settings – UC - Message Feature Allow 

Enable if the UC Suite User will be allowed to send and receive 

Phone Messages. 

This item is not relevant to Softphone. Leave as Default: 

Disabled 

0 = Disable 

1 = Enable 

0 

20-59-11 UC Server Settings – UC - Phone Monitor Allow 

Enable if the UC Suite User will be allowed to view the current call 

state of other extensions. 

This item is not relevant to Softphone. Leave as Default: 

Disabled 

0 = Disable 

1 = Enable 

0 
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CMD/Item Description Value Default 

20-59-12 UC Server Settings – UC - Block to be Monitored 

Enable if the UC Suite User's call state should be blocked from 

being viewed by other UC Suite users with Program 20-59-11 

enabled. 

This item is not relevant to Softphone. Leave as Default: 

Disabled 

0 = Disable 

1 = Enable 

0 

20-59-13 UC Server Settings – UC - Server Connect 

Enable if the UC Suite User's client will connect to the UC Server. 

This item is not relevant to Softphone. Leave as Default: 

Disabled 

0 = Disable 

1 = Enable 

0 

20-59-14 UC Server Settings – UC - License Level 

Define if the UC Suite User will us a Deskset, Softphone, or Deskset 

+ Softphone. (Deskset + Softphone is needed for UC Suite users 

controlling a deskset but require data conference). 

This should be set to  

This item should be set to Softphone 

0 = Softphone 

1 = Deskset 

2 = Softphone 
+ Deskset 

0 

20-59-15 UC Server Settings – UC - Login Mode 

Define if the UC Suite User will control a Deskset or be a 

Softphone. 

This item should be set to Softphone 

0 = Softphone 

1 = Deskset 

0 

20-59-16 UC Server Settings – UC - Attendant Mode 

Enable or Disable if the UC Suite User will have full Attendant type 

functionality like BLF Tabs, Phone Message, ability to change other 

users Presence States, Park Orbit Monitoring, detailed phone 

status monitoring, Pinning and Wide Column BLF. 

This item is not relevant to Softphone. Leave as Default: 

Disabled 

0 = Disable 

1 = Enable 

0 

20-59-17 UC Server Settings – UC - Trial Mode 

Enable or Disable if the client will come up in trial mode. Once this 

is set, the first time the client logs in the trial will be active on that 

PC for 30 days. 

Default: Disabled. Enable if wish to try free for 30 days 

0 = Disable 

1 = Enable 

0 

20-59-18 UC Server Settings – UC - Voicemail Interface 

Enable if the UC Suite user will have Voicemail integration. 

Enable if have purchased the InMail Integration license 

0 = Disable 

1 = Enable 

0 

20-59-19 UC Server Settings – UC - Agent Mode 

Enable if the UC Suite user will use Contact Center integration. 

This item is not relevant to Softphone. Leave as Default: 

Disabled 

0 = Disable 

1 = Enable 

0 

20-59-20 UC Server Settings – UC - Abandon Callback 

Enable if the UC Suite user will use the Abandoned Call 

Alert Feature. 

This item is not relevant to Softphone. Leave as Default: 

0 = Disable 

1 = Enable 

0 
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The following are relevant items for the VoIP aspects, these are general VoIP aspects and not specific 

only to the Softphone. 

 
 

Program 

Number 

 
 

Program Name/Description 

 
 

Input Data 

 
 

Default 

10-12-03 GCD-CP10 Network Setup – Default 

Gateway 

Define the default gateway to be used by the 

GPZ-IPLE interface. 

0.0.0.0 ~ 126.255.255.254 

128.0.0.1 ~ 191.254.255.254 

192.0.0.1 ~ 223.255.255.254 

0.0.0.0 

10-12-09 GCD-CP10 Network Setup – IP Address 

Set IP address for GPZ-IPLE. 

This item is the IP Address to the Softphone 
will connect to 

0.0.0.0 ~ 126.255.255.254 

128.0.0.1 ~ 191.255.255.254 

192.0.0.1 ~ 223.255.255.25 

172.16.0.10 

10-12-10 GCD-CP10 Network Setup – Subnet Mask 

Define the Media Gateway Subnet Mask 

Address. 

128.0.0.0 | 192.0.0.0 | 224.0.0.0 

|240.0.0.0 | 248.0.0.0 | 252.0.0.0 

|254.0.0.0 | 255.0.0.0 

|255.128.0.0 | 255.192.0.0 

|255.224.0.0 | 255.240.0.0 

|255.248.0.0 | 255.252.0.0 

|255.254.0.0 | 255.255.0.0 

|255.255.128.0 | 255.255.192.0 

|255.255.224.0 | 255.255.240.0 

|255.255.248.0 | 255.255.252.0 

|255.255.254.0 | 255.255.255.0 

|255.255.255.128 

|255.255.255.192 

|255.255.255.224 

|255.255.255.240 

|255.255.255.248 

|255.255.255.252 

|255.255.255.254 

|255.255.255.255 

255.255.0.0 

10-20 LAN Setup for External Equipment – TCP 
Port 

Define the TCP port number for the LAN CTI 
and O&M communication between the 

GCD-CP10 and the UC Suite. 

Item 9 (1st Party CTI) should be set to 8282 

Item 11 (O&M Server) should be left as 
Default:8010 

Item 15 (Presence) should be set to 8383 

 

 

0 ~ 65535 

 

 External Device  

 External Device 9   

 (1st Party CTI) 

 = 0 

 External Device 11     

 (O&M Server) 

 = 8010 

 

84-26-01 IPL Basic Setup – IP Address 

Assign the IP address for each DSP on the 
GPZ-IPLE. 

xxx.xxx.xxx.xxx Slot 1 = 

172.16.0.20 
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The Following items are used to determine the softphone registration method: 
 

 
Program 

Number 

 
 

Program Name/Description 

 
 

Input Data 

 
 

Default 

10-46-01 DT700 Series Server Information Setup – 

Register Mode 

If set to 0, when the phone boots up it reports 

the ext. assigned in the phone or chooses the 

next available extension in the system. No 

password is required. 

If set 1 the SIP user name and password must 

be entered on the actual IP phone. These 

settings must match 84-22/15-05-27, or the 

phone does not come on-line. 

If set to 2, when the phone boots up it prompts 

user to enter a user ID and password before 

logging in. It checks this user ID/password 

against 84-22/15-05-27. If there is no match, 

the phone does not come on-line. 

0 = Normal 

1 = Auto 

2 = Manual 

0 

15-05-27 IP Telephone Terminal Basic Data Setup – 

Personal ID Index 

When the SIP Multiline telephone is using 

manual/auto registration, assign each phone a 

unique personal index. Then go to command 

84-22 to assign the user name and password. 

0 ~ 960 0 

84-22 DT800/DT700 Login Information 

Sets the User ID and password for the 

Personal ID index entered in 15-05-27. 

Any number None 
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The following items are used for the BLF/DSS and telephone emulation mode.  

 
Program 

Number 

 
 

Program Name/Description 

 
 

Input Data 

 
 

Default 

15-07-01 Programmable Function Keys 

Assign a function key to terminals. 

Line Key 1 ~ 48 

0 ~ 99 (Normal Function Code 

751 by default) 

00 ~ 99 (Appearance 

Function Code) (Service Code 

752 by default) 

Refer to the 

Programming 

Manual for 

default values. 

30-01-01 DSS Console Operating Mode 

Set the DSS system Console mode. 

0 = Business Mode 

1 = Hotel Mode 

2 = Monitor Mode 

3 = Business/ Mode 

0 

30-02-01 DSS Console Extension Assignment – 

Extension Number 

Set the extension number for the multiline 

terminal connected with the DSS console (up to 

eight digits). 

Maximum of eight digits. No Setting 

30-03-01 DSS Console Key Assignment 

For DSS Console Chaining, assign an Speed 

Dialing Service Code (or) plus a 2-digit bin 

number to a DSS Console key. 

Key Number 

001 ~ 114 

0 ~ 99 (General Functional 

Level) 

97 = Door Box Access key 

(additional data: 1 ~ 8 Door Box 

No.) 

 00 ~  99 (Appearance 

Functional Level) 

Refer to the 

Programming 

Manual for 

default values. 
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Chapter 3 - UC Client Startup 
 

 

 
The UC Client can be started in any of the following ways: 

 Double-clicking on the NEC UC Suite icon within the Windows desktop area. 

 

 Selecting Start/All Programs/NEC/NEC UC Suite 

 
When the UC Client is started, the Login to the Phone System window appears: 

 Enter the SV9100 IP Address in System Address. 

 Enter the User Name and Password from Programs 20-59-01 and 20-59-02. 

 Check the Login as Softphone check box. 

 CRM integration should be selected if you wish to use the Highlight Dial and 

Call To features. 

 If the client will be a soft phone and the audio settings need to be changed, 

check the Change Audio Settings check box. 
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1 Toolbar 
 

The Toolbar Mode presents valuable information about the current call activity and 

provides easy access to the basic operations required by the normal phone user. The 

Toolbar User Interface (UI) layout takes up a minimum amount of space on the 

desktop, so as to not interfere with the operation or viewing of other applications. An 

example of the Toolbar Mode is shown below. 

 

 
 

 

The toolbar consists of the following areas: 

 
Dial String Field Specifies the number to be dialed and maintains a list of the most recently 

dialed numbers. 

Call Status Area Color-coded icons represent the status of active calls. 
 

Dial/Hangup Button Controls the hookswitch state of the phone. 
 

Speed Dial List Displays a user-maintained list of frequently dialed numbers. 
 

File Button Provides access to additional menu items, such as configuration settings 

and additional application views. 

Hold Button Places the active call on Hold. 
 

Function Toolbar Provides quick access to the most commonly used call processing 

and application functions. 

 

 

2 Toolbar Items 
 

Each of these screen regions is further described in the sections to follow. 
 

2.1 Dial String Field 

¿ The Dial String Field is a combo box in which the user specifies the phone 

number to be dialed. 

¿ The drop down list for this field contains the most recently dialed numbers. 

¿ The drop down list displays up to 20 numbers. 

¿ The numbers are listed with the most recent at the top. 

¿ Selecting a number from the list places the number as the current number to 
be dialed. 

 

¿ The user can enter a number in this field by manually typing in a number or 

using cut/paste. 

¿ With a phone number highlighted in another Windows application, pressing 
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<Ctrl+C> copies the selected number into the dial string field. 

 
2.2 Call Status Area 

¿ The Call Status Area is shown below the Recent Call List. 

¿ Round icons are used to represent the calls that are active on the phone. 

¿ The color of each icon indicates the call status as follows: 

 Ringing (Red) 

 Active (Green) 

 Held (Yellow) 

¿ When a call first enters the ringing state, a tooltip balloon is displayed over 

the call status icon. 

¿ Hovering the mouse over an icon displays the tooltip balloon for the 

selected call. 

¿ The following information is included in the tooltip balloon, based upon the 

type of call: 

 Line/Trunk Number 

 Connection Status 

 Calling Party/Called Party Identification 

 Time in current state 

 User-Defined Notes 
 

2.3 Dial/Hangup Button 

¿ The Dial/Hangup button is used to control the hookswitch function. 

¿ When the phone is idle, the button shows the Dial icon. 

¿ When the phone is busy, the button shows the Hangup icon. 

¿ Pressing the Dial button initiates a call to the number entered in the Dial 

String field. 

¿ Pressing the Hangup button disconnects the active call. 

 
2.4 Speed Dial List 

¿ The combo box next to the Dial button provides access to the Speed Dial 
list. 

¿ Clicking on an entry in the Speed Dial list immediately generates a call to 

the selected number. 

¿ Entries are added to the Speed Dial list through the Directory/Contact List/ 

Personal windows. 
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¿ A right-mouse click on a Speed Dial entry opens a menu that provides 

access to the following functions: 

 Edit – Open the associated database entry for editing. 

 Dial – Place a call to the selected number. 

 Transfer Immediate – perform a blind transfer of the active call to the selected 

destination. 

 Transfer Supervised – initiate a supervised transfer of the active call to the 

selected destination. 

 Conference – initiate a conference call with the selected destination. 

 E-Mail – create a new e-mail message with the selected name as the intended 

recipient. 

 Delete – remove the selected entry from the Speed Dial list. 
 

2.5 File Button 

 
The File button provides access to functions for configuring the application 

and changing the view/UI mode. The functions available from the File button 

are as follows: 

 
Preferences 

 
Customize application-level configuration settings. 

 

 
Call Log 

 
Open a separate window to view the call history. 

 

 
Directory 

 
Open a separate window to view the Directory/Contact List/Personal Directory. 

 

 
View 

 
Window Change UI mode to Full Window mode. 

 

Phone Image Display emulation phone image/control. 

 
 

Phone Image 

 
Open the emulation phone mode. 
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Links 

 
CallTo: Setup Opens a window Yes and No options for Enabling or Disabling 

the CallTo tag feature.  When Enabled, the CallTo tag feature 

provides the ability to dial from a CallTo tag/hyperlink within a 

web page or MS Office document using the Desktop Application. 

 

A Call To Tag will look like : Callto:200 

 

Highlight Dial Starts the Highlight Dial process in the system tray. The Highlight 

Dial process can be turned on or off. When turned on, 

highlighting a number in any program will automatically dial the 

number from the UC Suite. 

 

 Note: To use Call To or Highlight Dial, the Enable CRM must be selected 

on the logon screen, also Enable “third party interface" and "Enable XML 

interface" must be set in preferences. 

 

 

Help 

 
Contents and Index Access the on-line help system by topic. 

 

About View the copyright notice and current revision of the UC 

Client. 

 

 

Exit 

 
Close the UC Client. 

 

 
 

 

This same pop-up menu can be accessed by pressing the right mouse button 
while pointing at an open area within the toolbar. 

 
2.6 Hold Button 

¿ The Hold button places the active call on hold. 

¿ The Hold button is only enabled when a call is active on the phone. 

callto:200
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2.7 Function Toolbar 

 
The Function Toolbar provides quick access to the most commonly used call 

processing functions. A function on the toolbar can be selected by using the 

mouse to click on the desired function button or pressing the associated 

hotkey sequence on the keyboard. If additional information is required to 

complete the operation, then a supporting menu is displayed requesting 

additional input from the user. 

 
Individual buttons on the Function Toolbar become disabled if the function is 

not allowed for the current state of the telephone. For example, the Answer 

button is only enabled when a call is ringing on the telephone. 

 
Available functions are: 

 
Add/Edit Note  
Answer  
Auto Callback  
Page 
Background Music  
Barge In  
Callback Request  
Call Redirect 
Conference  
Display Message  
Dial  
Directed Call Pickup  
Do Not Disturb  
Forward Calls  
Group Call Pickup  
Hang Up 
Hold 
Last Number Redial 
Park 
Phone Image 
Phone Message 
Pickup Other Group 
Record 

Transfer 
Unpark 
Video 
Voice Mail 
Voice Over 

 

 

The operation of each of these functions is further described later in this 
document. 
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3 Emulation Phone Mode (Phone Image) 
 

The Emulation Phone is an on-screen representation of a deskset that can be opened 

through the Window or Toolbar modes. This user interface option is provided to allow 

users access to telephony functions through individual key presses. 

 

3.1 Emulation Phone Base Module 

 
The base module for the emulation phone simulates a 24-button deskset, as 

shown below: 

 

 
 

 

The emulation phone image operates in the same manner as a physical 
deskset, with the following exceptions: 

¿ The LCD display does not support the double-height setting. 

¿ The labels shown above the programmable keys are limited to six 

characters. 



 

 

 
¿ The JogKey (Round, four-position control) does not provide the same 

functionality as the physical phone. The up and down sides of the control 

will open the volume adjustment bar, and the left side will bring up the redial 

number. 

 
3.2 Emulation Phone Add-On Module 

 
The Phone Image tab on the Preferences menu allows the user to specify an 

expansion module be included in the phone image. When this option is 

selected, an eight-button add-on module will be displayed, as shown below: 
 

 
 
 

 

The add-on module operates in the same manner as the physical add-on 

module by providing eight programmable buttons to enhance the base 

module. 



 

 

 
 

3.3 Emulation Phone DSS Module 

 
The Phone Image tab on the Preferences menu allows the user to specify an 

attendant module be included in the phone image. When this option is 

selected, a 60-button DSS module will be displayed, as shown below: 
 

 

 

¿ Each button on the DSS module includes two LEDs. 

¿ The right LED is green and when lit indicates that a message is pending on 

the destination extension. 

¿ The left LED is red and simulates a solid lit LED, as well as supporting all of 

the different flash rates that are available on the physical DSS module. 

¿ The state of the red LED tracks the same conditions that affect the LED on 
the physical DSS module. 
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Chapter 4 -Toolbar Functions 
 

 

 
1 Tool Functions 

 
The function buttons which appear in the function toolbar on the Full Window, Toolbar, 

and Compact Phone modes provide access to the operations that are most frequently 

used by the phone user. The set of function buttons which are displayed can be 

customized by the user, as well as the size, order, and hotkey associated with the 

function. Configuration of the toolbar button layout is described in Application Level 

Configuration. 

 
Each button changes from active to inactive depending on the state of the calls 

managed by the application. The following table shows the set of functions that are 

active for different phone states. 
 

Table 1-1 Set of Functions – Telephone States 
 

Phone 
State 

Call Active 
Idle or Idle 

with Held Calls 
Idle 

Ringing 
Call 

Active+Ringing 
Other 

Conditions  

 
 
 
 
 
 
 
 
 

 
Feature 

Set 

Hold Dial Answer Hold Voice Over1 

Transfer Page  Transfer Video 

Hang Up Unpark  Hang Up Record2
 

Conference Night Mode  Conference  
Record Barge In  Record 

Park Directed Call Pickup  Park 

Add Note Group Call Pickup Add Note 

 Pickup Other Group  

 Last Number Redial  

 Call Forward  

 Do Not Disturb  

 Selectable Message 1 
Voice Over becomes enabled when the user dials a busy 

extension. 

2 
When using a deskset with the UC Client, an external recording 

interface, such as the ADA-L is required to enable Recording. 

 Additional switch programming and class of service 

permissions may be required to allow execution of some 

of the available functions. 

Background Music 

 

 

 

 



 

 

 
 

Each of the feature keys available in the function toolbar and their associated actions 

are described in the following sections. 

 

1.1 Answer 

 The Answer button allows the user to pick up a ringing line. 

 If only one line is ringing, then the Answer button connects the user to the 
ringing line and this becomes the active call. 

 If multiple calls are ringing, then the Answer key selects the oldest call. 

 If another trunk call is Active when the call is answered, then the original call is 

automatically placed on hold. If another internal call is Active when the call is 

answered, the original call is disconnected. 

 When a call is answered, the Active Call area (Full Window and Toolbar 
modes) is updated with an entry for the new call. 

 
1.2 Hold 

 The Hold function places the current active call on hold. 

 The Active Call entry changes from indicating Active to Held (Full Window and 

Toolbar modes). 

 After the Hold function is selected, the current Active Call area is empty (Full 

Window mode). 

 
1.3 Transfer 

 

The Transfer button initiates a transfer of the active call. When Transfer is 

initiated, the Transfer dialog is displayed below: 
 

 
 

 The user can manually enter the number to be dialed in the Destination field 

using the number keys in the main area of the keyboard or the number keys 

on the keyboard's keypad. 

 Alternately, the user can select an entry from the Destination drop down list. 

 The Destination drop down list includes a list of the most recent transfer 

destinations entered in this dialog box. 
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The actions associated with each of the dialog buttons are described in the 

following sections. 

 
1.3.1 Transfer Call – Start 

When the Start button is selected, the software will initiate a 

supervised transfer of the call. The Transfer dialog will be updated.  

 

 

 
 Selecting the Complete button will connect the original caller to the 

destination and disconnect the user. 

 Selecting the Disconnect button will hang up from the call to the 

Destination, and reconnect to the original caller. 

 

1.3.2 Transfer Call – Blind 

 When the Blind button is selected, the application will initiate an 

unsupervised transfer to the specified destination. 

 Once the transfer is complete, the active call will be removed from the 

active call area (Full Window and Toolbar modes). 

 

1.3.3 Transfer Call – Cancel 

 When the Cancel button is selected, the transfer operation will be 

cancelled and the Transfer dialog will be closed. 

 Pressing the Esc key will also initiate the Cancel operation. 

 
1.4 Hang Up 

 The Hang Up button will disconnect the user from the active call. 

 When the active call is disconnected, the associated entry in the Active Call 
list will be removed (Full Window and Toolbar modes). 
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1.5 Dial 

 
The Dial button allows the user to initiate an outbound call. When Dial is 
selected, the number in the dial field is called. 

 The user can manually enter the number to be dialed in the Dial field using the 

number keys within the main area of the keyboard or the number keys on the 

keyboard keypad. 

 Alternately, the user may select an entry from the Dial drop down list. 

 The Dial drop down list includes a list of the most recent dial destinations 
entered within this dialog box. 

 
1.6 Conference 

 
The Conference button will initiate a conference that adds a third party to the 

active call. When the Conference function is selected, the following menu will 

be displayed. 
 

 

 

 The user can manually enter the number to be dialed in the Destination field 
using the number keys within the main area of the keyboard or the number 

keys on the keyboard keypad. 

 Alternately, the user may select an entry from the Destination drop down list. 

 The Destination drop down list includes a list of the most recent conference 

destinations entered within this dialog box. 

 

The actions associated with each of the dialog buttons are described in the 
following sections. 
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1.6.1 Conference Call – Start 

When the Start button is selected, the application will place the 

original call on hold and initiate a consultation call to the specified 

destination. 
 

 

 

 Selecting the Complete button adds the consultation call to the original 

call, completing the conference setup. 

 Selecting the Disconnect button hangs up the consultation call and 

reconnects to the original caller. 

 

1.6.2 Conference Call – Cancel 

 When the Cancel button is selected, the conference operation is 

cancelled and the Conference dialog is closed. 

 Pressing the Esc key initiates the Cancel operation. 

 
1.7 Record 

 
The Record button allows the user to record the audio portion of the currently 

active call. Recording automatically stops when the active call is 

disconnected. 
 

 An ADA-L adapter is required for recording when the UC Client is run in Deskset mode. 

 The call recording is saved as a standard Windows sound file and associated 

with the call log record for the current call. 

 When recording is active, the text on the Record button will change to "Stop". 

 A setting in the Preferences/Recording tab selects whether manual recording 

is active or all calls are recorded automatically. 

 If the active call is placed on hold, the recording is stopped and automatically 

resumed when the call becomes active. 
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 Transfer and Conference operations do not affect the recording state. During 

these operations, the recording continues until the user has dropped out of 

the call, or the recording is manually stopped. 

 Only one recording can be associated with a single call record. If the Record 
command is invoked multiple times for a single call, then all recordings are 

concatenated into a single file. 

 The Stop button causes the recording to stop. 

 
1.8 Page 

 
The Page button allows the attendant to access the internal and external 

paging functions. When the Page function is selected, the following form will 

be displayed  
 

 
 

 

 The user specifies the Page zone category by selecting Internal, External, or 

Combined. 

 Within each Zone category, the combo box includes all of the available paging 

zones. 

 Selecting Start will initiate a Page to the designated paging zone. 

 Selecting Cancel will close the Page dialog without generating a Page. 
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1.9 Park 

 
The Park button will transfer the active call to a specific park orbit. When this 

function is selected, the following dialog will be displayed  
 

 

 

 The spinner control allows the user to select the destination Park orbit. 

 Selecting the Start button will place the active call in the selected Park orbit. 

 Selecting the Cancel button will close the Park Call dialog without initiating a 

call park operation. 

 If the Park operation fails because the selected Park orbit is not available, an 

error message will be displayed. 

 
1.10 Unpark 

 
The Unpark button will retrieve a call from a specific park orbit. When this 

function is selected, the following dialog in below, will be displayed. 

 

 
 

 The spinner control allows the user to select the destination Park orbit. 

 Selecting the Start button will attempt to retrieve a call from the specified Park 
orbit. 

 

 Selecting the Cancel button will close the Unpark Call dialog without initiating 

a unpark operation. 

 If the Unpark operation fails because the selected Park orbit is not occupied, 

an error message will be displayed. 
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1.11 Barge In 

 
The Barge In button allows the user to enter another extension’s established 

call. When this function is selected, the following dialog will be displayed (refer 

to below 
 

 
 

 The Number field allows the user to enter the extension to Barge In. 

 The Number field pull down list includes the most recent entries for this field. 

 When the Start button is selected, the Barge In feature will be applied to the 

selected extension. 

 When the Cancel button is selected, the Barge In dialog will close. 

 If the Barge In operation fails, an error message will be displayed. 

 The Barge In operation will fail if the specified extension does not have an 

established call. 

 The Barge In operation will fail if the user does not have the appropriate Class 

of Service permissions to execute Barge In. 
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1.12 Directed Call Pickup 

 
The Directed Call Pickup function allows the user to pickup a ringing call from 

a specified extension. When the Directed Call Pickup function is selected, the 

following dialog will be displayed  

 

 

 
 The Pickup Type field is automatically set to Directed Call Pickup. 

 The Number field allows the user to specify the extension to be picked up by 

either manually entering a number or selecting a number from the pull down 

list. 

 The Number field is a pull down menu that stores the most recent text entered 
in this field. 

 Pressing the Start button initiates the Call Pickup for the specified extension. 

 Pressing the Cancel button closes the Call Pickup dialog without executing 
the call pickup operation. 

 The Pickup Type field allows the user to initiate other call pickup features, 

including Group Call Pickup, Pickup Other Group and Call Pickup Specific 

Group. 

 
1.13 Group Call Pickup 

 
The Group Call Pickup function allows the user to pickup a ringing call from 

within their call pickup group. When the Group Call Pickup function is 

selected, the phone will initiate the group call pickup. 

 
1.14 Pickup Other Group 

 
The Pickup Other Group function allows the user to pickup a ringing call from 

within another call pickup group. When the Pickup Other Group function is 

selected, the phone will initiate the other group pickup function. 

 
1.15 Last Number Redial 

 
The Last Number Redial function allows the user to easily initiate a call to a 

previously dialed number. 
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1.16 Voice Over 

 
The Voice Over function allows the user to interrupt another user extension 

that is busy on another call. The Voice Over function is enabled when the user 

has dialed a busy extension. Selecting the Voice Over function at this time will 

connect the user to the busy extension. 
 

1.17 Call Redirect 

 
The Call Redirect function allows the user to send a call that is ringing on their 

extension to a different destination. The Call Redirect function is enabled 

when an external call is ringing into the user’s phone. Selecting the Call 

Redirect function will transfer the ringing call to the pre-defined redirect 

location. When the Call Redirect Function is selected, the following dialog will 

be displayed. 
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1.18 Call Forward 

 
The Call Forward function allows the user to set their phone to automatically 

redirect incoming calls. When the Call Forward function is selected, the 

following dialog will be displayed 
 

 
 

 This function can be used to either activate Call Forwarding or to Cancel Call  
  Forward settings. 

 The Forward On field determines the conditions for Call Forwarding. Available 

options are: 

 Busy or Not Answered 

 Immediate 

 Not Answered 

 Immediate with Ringing 

 
 Both Ring 

 Busy 

 The Destination field specifies the phone number to receive the forwarded 
calls. 

 The Destination field includes a drop down list which saves the previously 

specified forward destination. 

 Pressing the Start button will initiate the Call Forward operation. 

 Pressing the Cancel function will close the Call Forward dialog without 
changing the settings. 
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1.19 Do Not Disturb (DND) 

 
The Do Not Disturb function allows the user to set their phone to block 

incoming calls. When the Do Not Disturb function is selected, the following 

dialog will be displayed 

 

 

 

 The Do Not Disturb dialog allows the user to either set DND or clear a 
previous DND setting. 

 When “Set Do Not Disturb” is selected, the user can specify the DND 

condition using the “Applies to:” field. 

The available DND options presented in the “Applies to” field are: 

 All Calls 

 Outside Calls 

 Paging/Intercom/Forwards/Transfers 

 Call Forwards 

 The “Cancel Do Not Disturb” is selected to remove a previous DND setting. 

 Selecting the Start button will initiate the requested DND operation. 

 Selecting the Cancel button will close the Do Not Disturb dialog without 

processing the DND request. 
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1.20 Custom Message 

 
The Custom Message function allows the user to select a display message to 

be shown when other users call the user’s extension. When the Custom 

Message function is selected, the following dialog will be displayed  
 

 
 

 The Message field provides the list of pre-defined messages from which the 
user can select. 

 Available options in the Message field are as follows: 

 In Meeting Until 

 Meeting Room 

 Come Back 

 Please Call 

 Busy Call After 

 Out for Lunch Back 

 Business Trip Back 

 Business Trip 

 Gone for the Day 

 On Vacation until 

 Message 11 through Message 20 

 Based upon the Message that is selected, the Date, Time, and Number fields 

are enabled/disabled. 

 The Date field allows the user to specify a date to be included as part of the 

message. 

 The Time field allows the user to specify a time value to be included with the 

message. 

 The Number field allows the user to specify a numeric value to be included 

with the message. 
 

 Selecting the Set button will assign the specified Custom Message to the 

phone. 

 Selecting the Clear button will remove the assigned message from the phone. 

 Selecting the Cancel button will close the Message dialog without processing 

the custom message operation. 
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1.21 Background Music 

 The Background Music function will send audio from a music source to the 

user’s telephone. 

 When Background Music is enabled, the music will be played whenever the 
phone is idle. 

 If Background Music is enabled, then selecting the Background Music a 

second time will disable the feature. 

 
1.22 Auto Callback 

 The Auto Callback function allows the user to request a callback from another 
extension. 

 The Auto Callback function can be applied whenever the user dials an internal 

extension that is either busy or does not answer. 

 After setting a callback, the destination extension will callback the local 

extension when the phone is idle or the user next uses the telephone. 

 
1.23 Phone Image 

 The Phone Image button is only available when controlling an IP Softphone. 

When the Phone Image button is selected, it will launch the emulation phone 

view. 
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1.24 Add Note 

 
The Add Note function can be used to annotate the active call. When the Add 

Note function is selected, the following dialog will be displayed 
 

 
 
 

 The Note field allows the user to enter a text message that will be saved with 

the call record. 

 Selecting the OK button will close the Add Note dialog and attach the note to 

the call record. 

 Selecting the Cancel button will close the Add Note dialog without changing 

the note field. 

 The Clear function will erase the contents from the Note field on the Add Note 
form. 

 If a note is attached to a call record, selecting the Add Note function will allow 

the user to edit the existing note. 

 When a Note is attached to a call record, the Note will be shown within the 

active call entry (Full Window and Toolbar modes). 
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2 Directory View 
 

An online company directory, contact list, and personal list are provided to assist the 

user in handling call activity. The Directory provides the user with quick access to 

contact information and an easy method to send calls and messages to other 

extensions on their phone system. The Directory is populated automatically. The 

Personal List is a private version of an on-line phone/address book. The Directory, 

Contact List and Personal List are displayed in a separate window from the call 

control application to provide additional flexibility in the management of call activity. 

 

The directory is populated from the following data 

 

First Name 20-57-04 - First Name 

Last Name 20-57-03 - Last Name 

Extension 20-59-05 UC-Deskset Extension or if  
does not exist then 20-59-06 UC-Softphone Extension 

Extension Name 15-01-01 Extension Name corresponding to 'Extension' value 

E-Mail 20-57-16 - E-Mail1 

Department 20-57-19 - Department/Division 

Company Name 20-57-18 - Company 

City 20-57-20 - City 

State/Prov 20-57-21 - State/Prov 

Zip/Postal 20-57-22 - Zip/Postal 

Country 20-57-23 - Country 

Profile Note 20-57-24 - Profile Note 

Softphone 20-59-06 UC-Softphone Extension 

Telephone1 20-57-07 - TEL1 

Telephone2 20-57-10 - TEL2 

Telephone3 20-57-13 - TEL3 
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2.1 Opening the Directory View 

 To open the Directory View from Standard Window mode, select 

Window → Directory from the main menu. 

 To open the Directory View from Toolbar mode, select 
File → Directory. 

 
Directory View Screen shows an example of the Directory View. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

59  

 

The Directory consists of the following areas: 

 

Title Bar and Main 

Menu 

Provides the standard windows controls and access to standard 

operations and utilities through the pull down menus. 

Function Toolbar Provides quick access to functions that maintain the directories and 

change the database view. 

Search Area Allows the user to quickly locate an entry in the table by name. 
 

Table Viewer Presents the database contents in a tabular format with each 

column showing a different data item for the listed entries. 

 

 

2.1.1 Title Bar and Main Menu 

The Title Bar and Main Menu provide the standard windows 

controls and access to basic operations and utilities through pull 

down menus. 

The standard Windows controls on the Title Bar are as follows: 

 

Minimize Hide the Directory View and include an entry to restore 

the form in the Windows task bar. 
 

Maximize/Restore Change the size of the Directory View. Maximize 

increases the size of the window to fill the entire display. 

The Restore function reduces the size of the window to 

the previous dimensions. 

Close Exit the Directory View. 

 

 

The Main Menu provides a drop down menu, which lists all of the 

functions available within a selected category. The functions 
available from the Main Menu are as follows: 

 
File 

 

New Entry Add a new entry to the current database. (Only 

available for Personal Contacts area on Softphone) 
 

Companies Setup a new Department or Company within the 

database. (Only available for Personal Contacts area  

on Softphone) 
 

Properties Edit the current settings for the selected database 

entry. 

Delete Remove the selected entry from the database. (Only 

available for Personal Contacts area on Softphone) 
 

Print Print the contents of the database. Available print 

options are: Print All, Print Selected, Page Setup, 

and Print Preview. 

Exit Close the Directory View. 
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Edit 
 

Select All Select all entries in the database. 
 

Search Use the Search function to locate an entry by 

Name. 

 

 

View 
 

Hidden Entries Hide/Unhide entries that have their visibility 

attribute set to "Hide". 
 

Set Visible Actions Hide/Unhide the list of actions that appear in the 

pop-up menu. 
 

Set Visible Columns Hide/Unhide the columns that appear in the Table 

Viewer. 

 
Help 

 

Contents and Index Access the on-line help system by topic. 
 

 

 

2.1.2 Function Toolbar 

The Function Toolbar provides access to the functions that are 

used to maintain the database and change the layout of the Directory 

View. A function on the toolbar can be selected by using the mouse 

to click on the desired function button. 

The functions available on the Function Toolbar are as follows: 
New 

 
(Only available for Personal Contacts area on Softphone) 

New Entry 
 

New Department 

 

 
Delete 

(Only available for Personal Contacts area on Softphone)
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Print 
 

Print All 
 

Print Selected 

Page Setup 

Print Preview 

 
Action 

     (The following vary depending on if in Directory or Personal Contacts area) 

Dial Extension 

Dial Alternate 

Voicemail 

Transfer 

Conference 

Voice Over 

Camp 

Call Pickup 

Email 

Quick Message 

Phone Message 

Add Note 

Properties 

Delete 

Add to Speed Dial 
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2.1.3 Search Area 

The Search Area allows the user to quickly locate an entry in the 

database by Name field. The following rules apply to using the 

search area: 

 To access the Search capability click inside the Search field on the 

Directory window. 

  To search for entries that match the first name, enter the full or partial 

search string in the Search field. Example: Entering "John" will list all 

entries with first names of John and Johnny. 

 To search for entries that match a full or partial first and last name enter 

the first name, followed by a space, followed by the last name. 

Example: Entering "John Stevens" will list John Stevens and Johnny 

Stevenson. Example: Entering "S T" will list all entries whose first name 

starts with S and last name starts with T. 

 To search for entries that match only the last name enter a space as the 

first character in the Search field, followed by the full or partial last 

name. Example: Entering " T" will list all entries whose last name starts 

with T. 

 To Clear the Search results delete all the characters in the Search field 

or press the Esc key on the keyboard while the cursor is in the Search 

field. 

 

2.1.4 Table Viewer 

 The Table Viewer displays the contents of the selected database in 

tabular format. 

 Each column represents a field within the database structure. 

 Each row represents an entry within the selected database. 

 The column widths can be adjusted by “dragging” one edge of the 

column in the header row to a new position. 

 The column order can be changed by dragging the column header to a 

new position. 

 The visible columns can be modified by using the View → Set Visible 

Columns function on the main menu. 
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 A right mouse click on a row will open a pop-up menu that displays all of the 

available functions for that entry. 

 A double click on an entry when the phone is idle will initiate a call to the 

selected entry. 

A configuration option set in Tools → Preferences → Shortcuts defines the 

action when the user double-clicks on a busy directory entry with an 

active call. The options are: 

 Send active call to voice mail for the selected extension. 

 Put caller on hold and initiate voice over. 

 Camp caller on second line of selected extension. 
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2.2 Company Directory 

 
The Directory database is generated automatically when the softphone starts. 

 
 

2.2.1 Printing the Directory 

 From the File menu, selecting the Print option, followed by Print All will 

cause the entire directory to be sent to the default printer. 

 Highlighting a set of entries to be printed and selecting 

File → Print → Print Selected from the main will cause the selected 

directory entries to be sent to the default printer. 

 
2.3 Personal Lists 

 
The Personal database is used to maintain a list of personal contacts. 

 
Personal Contacts can be imported into the directory from a .csv file. From the 

File menu, Import and Export options are available to create and maintain the 

Contacts and Personal Contacts database via a .csv file. 

 
Operations that can be performed using the Personal database is described in 

the following sections. 

 
2.3.1 Adding a New Entry to the Contacts/Personal List 

On the File menu selecting New Entry will open the following form to 

create a new entry 
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 The following fields are configured for text entry: 

 First Name 

 Last Name 

 Telephone 

 Title 

 E-Mail 

 Address 

 City 

 State/Prov 

 Zip/Postal 

 Country 

 Notes 

 The Company Name field is a drop down list of all of the Companies 

that have been defined. 

 To enter an alternate number, select New in the Alternate Number 

area, and enter the telephone number and type. 

 Selecting Save will add the new entry to the Directory and exit the 

Directory Maintenance menu. 

 Selecting Add will save the new entry and clear the form for a new 

entry. 

 To add a new Department to the Directory, from the New button within the 

Directory window, select New Department, enter the name of the 

department and click OK. 

 

2.3.2 Modifying an Entry in the Contacts/Personal List 

 Highlighting an entry and from the File menu, selecting Properties will 

open the database form for the selected entry. 

 To modify an Alternate Number, select an Alternate Number and then 

click the Modify button to view and edit the current number and type 

fields. 

 Clicking on OK will apply the changes to the Contacts/Personal list. 

 Clicking on Cancel will discard the changes to the Contacts/Personal. 

 

2.3.3 Deleting an Entry from the Contacts/Personal List 

 Selecting the entry with a right mouse click and selecting the Delete 

option on the pop-up menu will remove the selected entry from the 

database. 

 Highlighting the entry and from the File menu selecting the Delete 

option will remove the selected entry from the database. 

 Highlighting multiple entries and applying the Delete command will 

delete all of the entries in the selected range. 
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2.3.4 Printing the Directory 

 From the File menu, selecting the Print option, followed by Print All will 

cause the entire database to be sent to the default printer. 

 Highlighting a set of entries to be printed and selecting 

File → Print → Print Selected from the main menu will cause the 

selected database entries to be sent to the default printer. 

 

 

SECTION 3 CALL LOG VIEW 

 
The UC Client maintains a Call Log, which provides a historical trace of the user’s call 

activity. Each inbound and outbound call generates a record in the call log. This 

information can be used to retrieve details about specific calls and perform functions 

such as re-dialing a previous call or playing back a recorded telephone conversation. 

 

3.1 Opening the Call Log 

 To open the Call Log from Full Window mode, select Window → Call Log from 

the main menu. 

 To open the Directory View from Toolbar mode, select File → Call Log. 

 
Call Log Screen shows an example of the Call Log View. 
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The Directory consists of the following areas: 

 The Title Bar and Main Menu provides the standard windows controls and 

access to standard operations and utilities through the pull down menus. 

 The Filter Toolbar allows the user to apply filters to the visible call records. 

 The Record Viewer presents the call log records in a tabular format with each 
column showing a different attribute of the call record. 

 
Each of these screen regions is further described in the following sections. 

 
3.1.1 Title Bar and Main Menu 

The standard Windows controls on the Title Bar are as follows: 

 Minimize – Hide the Call Log View and include an entry to restore the 

form in the Windows task bar. 

 Maximize/Restore – Change the size of the Call Log View. Maximize 

increases the size of the window to fill the entire display, the Restore 

function reduces the size of the window to the previous dimensions. 

 Close – Exit the Call Log View. 

The Main Menu provides a drop down menu, which lists all of the 

functions available within a selected category. The functions 

available from the Main Menu are as follows: 

 Call Log 

 Delete – Delete a call record from the Call Log. 

 Print – Print the contents of the call log. Available print options are 

Print All, Print Selected, Page Setup, and Print Preview. 

 Archive – Save the call history to an external file. 

 View 

 Set Visible Columns – Hide/Unhide the columns that appear in the 

Call Log. 

 

3.1.2 Filter Toolbar 

The Filter Toolbar allows the user to select the set of call records that 

will be displayed in the Call Log view, as follows: 

 Selecting Inbound will only display the call records for incoming calls. 

 Selecting Outbound will only display the call records for outgoing calls. 

 Selecting Missed will only display the incoming calls that were not 

answered. 

 Selecting All will display the entire list of call records. 
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3.1.3 Record Viewer 

 The Record Viewer displays the list of call records as indicated by the 

selected filter. 

 Each column represents an attribute of the call record. 

 Each row represents a call record. 

 A disk icon in the Type column indicates that a recording is attached to 

the call record. 

 The column widths can be adjusted by “dragging” one edge of the 

column in the header row to a new position. 

 The column order can be changed by dragging the column header to a 

new position. 

 The visible columns can be modified by using the View → Set Visible 

Columns function on the main menu. 

 

 
 

 A right mouse click on a row will open a pop-up menu that displays all of 

the available functions for that record. 

 A double click on an entry when the phone is idle will initiate a redial to 

the selected entry. 
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3.2 Playing Back a Recorded Telephone Conversation 

 
Pressing the right mouse button to select a record that contains a recording 

and selecting play from the pop-up menu will initiate playback of the recording. 

 
The Playback window will open during playback 

 

 

 
The Playback window provides the following controls: 

 

Slider bar - advances as the playback progresses. 

Dragging the slider changes the current playback 

position within the recording. 

 
 

Play Start/resume playback of the recording. 

Pause Suspend playback at the current position. 

 

Stop 
Suspend playback and set the current position to 

the beginning of the recording. 

 

 

3.3 Deleting a Record from the Call Log 

 Selecting a record with a right mouse click and selecting the Delete option on 

the pop-up menu removes the selected record from the Call Log. 

 Highlighting a record and from the Call Log menu and selecting the Delete 

option removes the selected record from the Call Log. 

 Highlighting multiple records and applying the Delete command deletes all of 

the records in the selected range. 



 

 

 

3.4 Printing the Call Log 

 From the Call Log menu, selecting the Print option, followed by Print All 

causes the entire call history to be sent to the default printer. 

 Highlighting a set of records to be printed and selecting Call Log → Print → 

Print Selected from the main menu causes the selected call log entries to 

be sent to the default printer. 

 
3.5 Archiving the Call Log 

 
Archiving the Call Log is beneficial for reducing the number of call records 

displayed within the application, and therefore, improving access when 

searching for individual records. The archival process also provides a method 

of backing up the call history and storing the records off-line for future access. 

 From the Call Log menu, selecting the Archive option opens the Call Log 

Archive menu 
 

 
 

 Selecting the Start Date and End Date for the archive specifies the range 

of records to be archived. 

 Selecting “Save voice recordings in corresponding .zip” will create a 

separate zip file that includes all of the attached recordings. 

 Selecting “Delete voice recordings” will delete the recordings files when 

the archive is created. 

 The Archive File Location field specifies the name of the file that will 

be created to hold the archive. 
 
 

 Selecting Archive will create the specified archive file in CSV (Comma 

Separated Values) format. 

 After the archive file is created, all of the selected archive records will be 

removed from the call log. 

 Selecting Cancel will close the Call Log Archive dialog without creating an 

archive file. 
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Chapter 5 - Application Level Configuration 
 

 

 
1  Introduction 

 
The Preferences function allows the user to customize the UC Client user interface 

and operation. 

 From the Full Window mode, the Preferences settings can be accessed by 
selecting Tools → Preferences on the main menu. 

 From the Toolbar mode the Preferences settings can be accessed by selecting File 
→ Preferences. 

 

2 Preferences Menu 
 

When the Preferences function is selected, the following is displayed. Each of the 

tabs is described in the following sections. 

 

2.1 Preferences – General 
 

 
 

 

 



 

 

 
 

 The Pop-Up on incoming calls option applies when the application in Full 

Window mode is minimized. If this option is selected, the application will be 

restored from a minimized state when an incoming call is received. 

 The Make top application on incoming calls applies to the Full Window 
mode. When selected, this option causes the application window to become 

the top active application when an incoming call is received. 

 The Enable E-Mail integration option can be selected to utilize a 

MAPI-compatible e-mail client in conjunction with the desktop application. 
E-mail functions are provided within the call log and for directory/contact list 

entries that have designated e-mail addresses. 

 The Enable ringing through PC speakers option controls whether a ringing 
tone is played through the default sound device for each incoming call. 

 The Show confirm dialog on exit controls if a confirmation dialog is 

presented each time the user closes the application. 
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2.2 Preferences – BLF/DSS 
 

 
 

 The Visible Tabs list controls the tabs that are visible and hidden on the BLF 

panel. Only the tabs that are checked are shown on the BLF panel. 

 The Move Up and Move Down buttons allow the user to re-arrange the order 
of the BLF tabs. Selecting an entry and then pressing one of these buttons 

moves the entry in the desired direction. 

 The New button is non-functional in Softphone mode 
 

    The Delete button removes the selected BLF tab from the list 
 

    The Properties button opens up the definition window for the selected BLF tab. 
 

    The Label Format option allows the user to specify which values are shown on    
      each BLF button (Extension only, Name only, or both Extension and name). 

 

 The Name Display option allows the user to select the format used in the BLF 
and Directory for displaying First Name and Last Name. 

 The BLF Appearance area only has a Large Button option for size on the 

Softphone. Show animation has no effect in Softphone mode. 
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2.3 Preferences – Recording 
 

 

 

 The Recording Device selector allows the user to specify which recording 
interface is to be used to record calls. If no recording device is detected, then 

this option is disabled. 

 The Record All Calls option allows the user to specify that recording is 
automatically started for every call. 

 The Enable beep tone while recording option plays a beep tone at the start 

of recording to alert the parties on the call that recording is taking place. 
 
 

2.4 Preferences – Personal Greeting 

 
   Personal Greeting is not available on Softphone. 
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2.5 Preferences – Playback 
 

 
 

 The Playback Device option allows the user to specify the audio device used 

for playing back recordings. 

 The Playback through ADA option specifies whether or not recordings play 

back through the ADA-L adapter on deskset stations only and is not an 

option for Softphone. 



 

 

 
 

2.6 Preferences – Tool Buttons 

 

 

 

 The Available Tool Buttons lists all of the function buttons that are available 
within the application. 

 Only the entries that are checked are shown on the function toolbar. 

 The Move Up and Move Down buttons are used to re-arrange the order of 
the function buttons. 

 The Accelerator field is used to specify a hotkey to associate with a function. 
The Description text explains how to set a hotkey for a function. 

 The Image Size option allows the user to select the size of the buttons on the 

toolbar (Small, Medium, Large). 



 

 

 

2.7 Preferences – Shortcuts 
 
 

 
 

 The One touch transfer will initiate option specifies which action type of 
transfer (Supervised or Immediate) is initiated when the user clicks on an idle 

BLF button (Full Window Mode) with an active call. 
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 The Double-click on a busy extension option allows the user to specify the 

action to be initiated from the BLF panel or Directory when double clicking a 

busy extension. Only the Send active call to voicemail is possible with 

Softphone. 

 The Pressing the <Enter> key will send the chat message option allows 
the user to designate whether the Enter key is used as a method to send a 

Chat message. If this is not selected, then the user must press the Send 

button on the Chat window to send a message. 

 The Enable Highlighted Dial Feature option turns on the ability to Highlight a 

number in any program and have the Desktop Automatically call that number 

when the number is copied, or paste it into the dial field and it will be dialed when 

the users selects Dial. The Hot Key can be in a range from Ctrl-F1 through 

Ctrl-F12. 

 
2.8 Preferences – Telephony Settings 
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 The Feature Codes list displays all of the telephone features that are used by 

the application. 

 When an entry in the Features list is selected, the Feature field shows the 

feature access code that is currently set within the UC Client. 

 The Get Values button retrieves the current feature access code settings 

from the phone system. 
 

 The text below the Get Values button shows the last time that the O&M 

interface was successfully used to retrieve the access code settings from the 

phone system. 

 The Internal Paging Zones option specifies the range of Paging Zones that 
are defined in the telephone system. 

 In the Immediate Transfer section, select the Use consult call for 
immediate transfer option when transferring to stations that are call 

forwarded off site. 

 In the Incoming Calls section, select the Ignore incoming calls that do not 

alert the phone option when the station has keys that flash but do not ring 

(for example: virtuals with delay or no ringing). 
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2.9 Preferences – Voice Mail 

 

 
 

 The Enable Voicemail Interface option controls if the voice mail functions 
within the application are enabled. 

 The Voicemail Pilot Number is specified if transfers to voice mail require the 
pilot number to be utilised instead of the quick transfer to voice mail service 

code. The Voicemail Pilot Number should also be entered for Voicemail to be 

an option when setting forwarding based on Presence settings. 

 The Enable Access to voicemail messages and greetings needs to be 

checked to access the mailbox. 

 If the mailbox requires a password for login check the Password required for 

voicemail login box. 

 Define the Password for the mailbox 



 

 

 
 

2.10 Preferences – Notification Settings 

 

 

 

 Check the Display an alert for new Voice Mail messages check box to 
receive a notification in the system tray when a new voice message arrives. 

 This is only supported with VM8000 InMail. UM8000 Mail does not support 
Voicemail notification in UC Client. 

 Check the Display an alert for missed calls check box to receive a 

notification in the system tray when a call has been missed. This applies to 

both IP Softphone and Deskset. 

 The Alert Display section specifies how the alert will display. The alert can be 
displayed by clicking the system tray icon, it can be displayed automatically 

and held until dismissed, or it can be displayed and fade similar to the way a 

new email in MS Outlook is handled. 



 

 

 

2.11 Preferences – Instant Message 

 
This item in unavailable for softphone 

 

2.12 Preferences – Video Settings 

 

 

 
 The Device field allows the user to specify which camera is used for the video 

call function. 

 The Frame Rate and Bit Rate fields allow the user to control the quality of the 

video transmission. 

 The Mirror My Image option reverses the self-image within the video window. 

 The Start sending when call is started automatically starts transmitting the 

video image when the video call is connected. If this option is not set, the user 

must use the Send button on the video window to start transmitting their video 

image. 
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 The Connect with voice party option automatically attempts to start a video 

call session when the Video option is selected. The video session is 

requested with the active voice caller. 

 The End video when voice call ends option stops the video transmission 
automatically when the associated voice call is terminated. 

 
2.13 Preferences – Phone Image 

 

 

 
 When the Expansion Module option is selected, the phone image will include 

an 8-button add-on module. 

 When the Attendant Module option is selected, the phone image will include 

a 60-button DSS module. 
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2.14 Preferences – Audio  

 
 

 Audio Device allows you to select the audio device, such as PC speakers or 

USB handset 

 Enable Core Audio Option to use high quality audio requires audio 

devices support for frequencies in multiples of 8000Hz (48000/96000Hz, etc). 

Disabling this option will allow support for audio devices which do not support 

these frequencies. Disabling this option means that the Operating System 

audio driver will transcode the audio into the necessary output frequency. 

This will result in higher CPU utilisation. 

 Special Audio is for USB Handset if plugged in. This then opens the options 

underneath allows you to select the audio device, such as PC speakers or 

USB handset 

 

 
 



 

 

Chapter 6 - Softphone Registration 
 

 

 
 

The UC Client registers with the SV9100 system as an IP Station in Softphone 

Program 20-59-14.  

 
 

1 Registration Types 
 

There are three types of registration; Plug and Play, Automatic, and Manual. Plug 

and Play requires no user name and password. Automatic is not supported for UC 

Suite. Manual requires a user name and password and the user is prompted to enter 

them. 

 
Manual registration is required if the Softphone if want to add extra security and the 

option to hotdesk. 

 
If manual mode is used, the user must enter a user name and password, this is 

prompted after the initial dialog box on opening.  



 

 

 
 

Chapter 7 - Data Conference 
 

 

 
1 Introduction 

 
Data Conference provides support for Video Conference (maximum of eight parties), 

Communications Board, File Transfer and Chat. Data Conference can be accessed 

from the Function Toolbar or the More drop down. The image below is an example of 
a Data Conference. Data Conference is not supported under Windows 10. 

 
 

 
 

 

 

The following sections describe how to use the Data Conference module for Chat, 

File Transfer, Video and Communications board. 



 

 

 

2 Starting a Data Meeting 
 

1. When on a call with another UC Client user, click the Data Conference icon on 

the toolbar, or select Data Conference from the More drop down. 
 

 

 

 

2. The Choose Party Dialog box opens. Choose the other Desktop users to add to 
the Conference and click Start. 

 
 

 
 

 

3. The other party receives an Incoming Request Window. Clicking OK will open 

the Data Conference Window for them as well. 
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3 How to Use a Data Meeting 
 

For constrained conditions for data meeting, refer to "Constrained Conditions for Data 

Meeting". 

 In the case of VPCC mode, data meeting cannot be used. 

 
 

 
 
 

 

1. Click on the Data Meeting button. 

The Data Meeting screen appears. 
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The Data conference participation invitation dialog appears on the display of the 

other party. 

 

 
 
 

 

2. The other party clicks on the  button. 

The Data Meeting screen appears on the display of the other party. 

 

 
 
 

 

Data Meeting is now started. 
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3.1 Joining a Data Meeting 
 

1. The other party (organizer) clicks on the  Data Meeting button. 

The Data conference participation invitation dialog appears. 

 

 
 

 

2. Click on the  button. 

The Data Meeting screen appears. 

 

 

 
 

The Data Meeting is now joined. 
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4 Ending a Data Meeting 
 

You can end or leave a Data Meeting. 
 

4.1 Ending a Data Meeting 

 
1. Click on File then End Meeting and Exit. 

 

 
 

 

The Data conference end confirmation dialog appears. 

 

 
 

 

2. Click on the  button. 

The Preservation folder setting dialog appears. 
 

 

 
 

3. Click on the  button. 

 To save the data: 

On the Preservation folder setting dialog click OK to save the data. 

 
The Data Meeting ends. 
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4.2 Leaving a Data Meeting 

 
Participants can leave a data meeting. Even when a participant leaves a 

meeting, other participants can continue the meeting. 

 
1. You are in a Data Meeting. 

 
2. Click on File then Leave and Exit. 

 

 
 

 

The Data conference leaving confirmation dialog appears. 
 

 
 

 

3. Click on the button. 
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If data is currently registered, the Preservation folder setting dialog appears. 

 

 

 
 

4. Click on the button. 

 To save the data: 

Click the OK button on the Preservation folder setting dialog to save the data. 

 
5. You leave the Data Meeting. 
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5 Using Video Communication 
 

Allows Data Meeting participants to talk face-to-face. 

 Video communication is available only when you are talking with the other party. The Data 

Meeting button is not displayed when you are not talking with the other party. 

 

5.1 Icons 
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Table 7-1 Video Icons 
 

Button Name Description 

 

 

Update participant list Updates the participant list to the latest state. 

 

 

Display video in 

single-deck format 

Displays video in single-deck format. 

 

 
Display video in 

double-deck format 

Displays video in double-deck format. 

 

 

Stop video 

transmission 

Starts/stops video transmission. 

 

 

Stop video 

transmission/reception 

Starts/stops video transmission/reception. 

 

 

Organizer icon Indicates that the participant is the organizer. 

 

 

Data Meeting status 

icon 

Indicates if the user during a call can join or 

have joined the data meeting. 

 

 

Call status icon Indicates the status of the user during a call. 

 

 

5.2 Starting Video Communication 

 
1. You are in a Data Meeting. 

 

2. Click on the  Stop video transmission button. 

Your image is transmitted to the other party. 

 To start video communication immediately: 

You can start video communication immediately by clicking the Data Meeting button 

without clicking on the   Stop Video Transmission icon. For details, refer to 

"Configuring video transmission/reception". 
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3. The other party clicks on the Stop video transmission button. 

 
The other party's image is transmitted to your PC. Each PC displays the other 

party's image. 

 

 
 

4. Talk using video communication. 

 
Each PC displays the other party's image. 
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6 Using the Communication Board 
 

Data meeting participants can use the white board on their own PC. Participants can 

share data and write in the shared data freely to share and exchange information. 

 
Operations can be performed simultaneously. 

 

6.1 Icons 
 

 
 

 
Table 7-2 Common Icons 

 

Button Name Description 

 

 

Open/Close Toolbar 

button 

Switches display/nondisplay of the lower 

part of the toolbar. 

 

 
Data Name box Selects the data or displays the selected 

data name. 

 

 

Top Page button Displays the top page of the displayed data. 

 

 

Previous Page button Displays the previous page of the displayed 

data. 
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Table 7-2 Common Icons (Continued) 

 

Button Name Description 

 

 

Page Number area Displays the page number of the displayed 

data. 

 

 

Next Page button Displays the next page of the displayed data. 

 

 

Last Page button Displays the last page of the displayed data. 

 

 

Lock button Locks operations by other participants. 

 

 

Synchronization 

button 

Switches the synchronization status of the 

data or page switching with other terminals. 

 

 

Add Page button Adds a page to the white board. 

 

 

Save Data button Saves the data currently displayed. 

 

 
Scale box Changes or displays the scale of the 

displayed page. 

 

 

Select button Selects the Selection tool. 

 

 

Hand Tool button Selects the Hand tool. 

 

 

Eraser button Selects the Eraser tool. 

 

 

Erase All button Erases all objects created by yourself on the 

displayed page. 

 

 

Text button Selects the Text tool. 

 

 

Pen button Selects the Pen tool. 

 

 

Magical Pen button Selects the Magical Pen tool. 

 

 

Shape button Selects the Shape tool. 

 

 

Paste button Pastes the captured image data. 

 

 
Color Selection button Changes the color of objects. 

 

 
Line Width box Changes the line width of objects. 
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Table 7-2 Common Icons (Continued) 
 

Button Name Description 

 

 
Select Font button Changes the font of the Text tool. 

 

 

Lock Status icon Indicates whether you or another participant 

has locked the operation. 

 
 

6.2 Sharing Data 

 
Data can be shared at a meeting by data registration. Sharing Data is not 
currently supported in Windows 10 Operating System. It is possible to 
view the data shared by other clients. 

 
6.2.1 Drag and Drop 

 
1. Drag the data to be shared. 

 

2. Drop it on the Communication Board. 
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The Register document screen appears. The screen disappears 

automatically when the registration is completed. 

 

 

 
 

3. Select a file to be shared from the data name box. 

The data is displayed on the Communication Board of the 

participants. 

 

 
 
 
 

The data has now been shared. 
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6.2.2 Menu 
 

1. Select the Communication Board menu. 

 

 

 
 
 

2. Select Open Document. 

The Open screen appears. 

 

 
 
 

3. Select a file to be shared. 
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4. Click on the button. 

The Register document screen appears. The screen disappears 

automatically when the registration is completed. 

 

 

 
5. Select a file to be shared from the data name box. 

The data is displayed on the Communication Board of the 

participants. 

The data has now been shared. 
 

6.3 Turning a Page 

 
You can change the page of the data used for a data meeting. 

 
1. Select the Communication Board menu. 

 

 
 
 



 

 

 
 

2. Select Go To. 
 
 

 

 

 
First Page, Previous Page, Next Page and Last Page are displayed. 

 
3. Select Next Page. 

Or, click on the  Next Page button. 

The next page is displayed. 

 To use the button to turn a page: 

Refer to "Icons" for details. 

The page of the other party is not changed: 

You can turn a page only of your own data in the asynchronous state. click on the 

 Synchronization button. 

The page has now been turned. 

 
6.4 Saving the Shared Data 

 
The participants can write in the shared data freely. Your can save the file after 

writing in it in the format in which you have registered the data. 
 

 Only the user who has registered the data can save it. Handwriting, figures, and texts 

are saved as image. You can save the data only when the file format in which you have 

registered the data is Word or PowerPoint. 

Writing out of the written image (gray area) is not reflected in a Word file. 

 
1. The participants write in the shared data freely. 
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2. Select the Communication Board menu. 

 

 
 
 

3. Select Save Document. 

Or, click on the  Save Data button. 
 

 

 
 
 

The Save As screen appears. 
 

 
 
 

 

4. Specify the destination to save and input the file name. 
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5. Click on the  button. 

The Save Document screen appears. 
 

 

 

The data has now been saved. 



 

 

 

7 Using File Transfer 
 

You can transfer a file to the participants of a data meeting. 
 

7.1 Transferring a File 

 
Drag and drop the target file on the target screen. The Material distribution 
screen appears. 

 
1. You are in a data meeting. 

 
2. Select a file to transfer. 

 
3. Drag and drop it on the screen of the participant to whom you want to transfer it. 

 

 
 

 

Or, click File then File Transfer. 
 

 
 
 



 

 

 
 

The Material distribution screen appears. 

 

 
 

 

4. Select Specified user under Distribution target. 

 

 
 
 

 To transfer the file to all participants: 

Select All users in Distribution target to transfer the file to all participants. 



 

 

 
5. Select a Participant to transfer the file. 

 

 
 

 
 

 

6. Click on the button. 

 
The Distribution target confirmation screen appears. 

 

 
 

 
 



 

 

 

7. Click on the  button. 

The Transmission result screen appears. 

 

 

 

8. Click on the  button. 

The file has now been transferred. 

 
7.2 Receiving a File 

 
You can receive a transferred file and save it. 

 
1. Receive a file. 

 
The File reception screen appears. 

 

 
 



 

 

 
2. Specify the destination to save. 

 

 
 

 

3. Click on the button. 

 
The File Save completion screen appears. 

 

 
 

 

4. Click on the button. 

 To confirm the file immediately: 

Click the Open button on the File Save completion screen to open the received file 

immediately or to open the saved directory. 

Å Extensions of received files which immediately open TXT, DOC, XLS, PPT, PDF, 

JPEG, JPG,GIF, TIFF, MP3, WMV, AVI, HTML or HTM. 

Å Extensions of received files whose saved directory opens Extensions other than 

those above. 

 

The received file is saved into the specified directory. 



 

 

 

8 Using Chat 
 

You can communicate with the other party using characters (chat). You can give 

contents that are hard to convey in conversation (website address, address, etc.) 

easily. 

 

8.1 Icons 
 

 

 
Table 7-3 Chat Icons 

 

Button Name Description 

 

 

Save File button Saves all messages in the chat display area 

as a text file. 

 

 

Send Chat button Sends the message in the chat display area 

to all other participants. 

 

 

Display Whisper Chat 

screen button 

Displays the Whisper Chat screen to send 

whisper chat. 

 

 
Switch Display check 

box 

Sets whether to display the Whisper Chat 

screen after the message transmission. 

 

 
 

Send Chat button Sends the message in the chat display area 

to the participant specified in the Destination 

field. 
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8.2 Sending Chat 

 
1. You are in a data meeting. 

 
2. Click into the chat input area and input a message for the participants. 

 

 
 

3. Click on the  Send Chat button. 

Or, in the Chat menu click on Send. The input message is displayed on the 

display of other participants. 
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 To restrict the destination of a message: 

When three or more parties are using chat, you can send a message to a specific 

participant. For details, refer to "Sending WhisperChat". 

 
4. When you receive a message from a participant, the chat display area displays 

it. 

 
Repeat Steps 3 to 5 for conversation using characters. 

 

 
 

 
5. To save the content of the chat when you finish the chat, click on the Save 

File button. 

 
Or, in the Chat menu select Save. The Save As screen appears. 
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6. Specify the file name to save. 
 

 

 
7. Click on the button. 

 
8.3 Sending Whisper Chat 

 
You can send a message only to the specified participant. 

 
1. You are in a data meeting. 

 

2. Click on the  Whisper Chat button. 

The Whisper Chat screen appears. 

 

 

 
3. Select a destination to send whisper chat. 
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4. Click the chat input area and input a message. 

 

 

 
5. Click on the Send Chat button. 

 

 
 

The message is displayed in the chat display area in a color different from that 

of ordinary chat messages. 

6. Click on the  Close button. 

Or, click on File then Close. 

The whisper chat is sent. 
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9 Adding up to Eight Parties to a Meeting 
 

Up to eight parties can join a data meeting simultaneously. In addition to parties using 

Softphone, parties using an ordinary extension phone or using an external line can 

join a meeting. 

 
At the same time, a data meeting can be held among parties using Softphone. 

 To use this function, set the service function in the IP telephony server in advance. For details, 

contact the system administrator. 

 

9.1 Starting a Data Meeting from a Meeting 

 
A user who clicks the Data Meeting button during a meeting can organize a 

data meeting with the other parties. 
 

1. Each party joins a meeting.  

2. The organizer clicks on the Data Meeting button. 

   



 

 

 

While a data meeting is being started,  Preparing a Data Meeting icon is 

displayed. 

 
The Data Meeting screen appears. 

 

 
 

 

The Data conference participation invitation dialog appears on the display of the 

other parties. 

 

 
 

 

3. The other parties click on the button. 



 

 

 
The Data Meeting screen appears on the display of the other parties. 

 

 
 

The screen above shows an example of a 5-party meeting. 

The data meeting is started from a meeting. 

 

10 How to Use Various Settings 
 

You can set up various items for a data meeting. 
 

10.1 Displaying the Settings Screen 

 
1. Click Tool then Set Up. 

 

 
 



 

 

 
 

The Tool screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
10.2 Configuring Participants 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

You can change the settings of "Video sending and receiving setting", "Video 

sending and receiving quality setting", and "Change of capture device" on the 

Participants tab of the Settings screen. 
 

 When video is restricted in the service restriction, the Participants tab is not displayed 

on the Settings screen. 



 

 

 

10.2.1 Video Sending and Receiving Setting 

You can set whether to transmit/receive video simultaneously with 

the start of a data meeting. 
 

 

 

 To start video transmission/reception simultaneously with the start of a data 

meeting: 

Select The video sending and receiving begins at the same time as starting. 

to start video transmission/reception simultaneously with the start of a data 

meeting 

 To start only video reception simultaneously with the start of a data 

meeting: 

Select Only the video receiving begins at the same time as starting. (It  

doesn't sending.) to start only video reception simultaneously with the start 

of a data meeting. 

 To not transmit/receive video right after the start of a data meeting, but to 

start video transmission/reception manually: 

Select Not doing anything, and video sending and receiving setting 

immediately after start by hand power. to start video transmission/reception 

manually. 



 

 

 
 

10.2.2 Video Sending and Receiving Quality Setting 

You can set the quality of the video to be transmitted. 

 The change is reflected the next time you join a data meeting. 

 
 

 
 

 To use the high quality video transmission: 

Select High:  QCIF (176*144) to use the high quality video transmission for 

a data meeting. 

 To use the ordinary quality video transmission: 

Select Normal: QCIF (176*144) to use the ordinary quality video 

transmission for a data meeting. 

 To use the low quality video transmission: 

Select Low: QCIF (176*144) to use the low quality video transmission for a 

data meeting. 



 

 

 

10.2.3 Change of Capture Device 

You can change the camera to be used when two or more cameras 

are connected. 

 The change is reflected the next time you join a data meeting. 

 
 

 
 
 

 To restore all default values, click on the button. 

 

10.3 Configuring Communication Board 

 
You can change the settings of "Auto Save" and "Register Document" on the 
Communication Board tab of the Tool screen. 

 
 When the communication board is restricted in the service restriction, the 

Communication Board tab is not displayed on the Tool screen. 



 

 

 
 

10.3.1 Auto Save 

You can set whether to save the content of the Communication 
Board automatically when a data meeting ends. 

 

 
 

 To save the content of the Communication Board automatically: 

Check It  preserves it automatically and specify the destination to save it. The 

messages are saved automatically in the folder specified as the destination 

when a data meeting ends. 



 

 

 

10.3.2 Register Document 

You can specify whether to standardize the high-quality printing in 

registering Excel data. 
 

 
 

 To standardize the high-quality printing: 

Check The print qualities of the Excel sheet are united in high quality and 

document is registered. to standardize the high-quality printing. 

 To keep the printing quality: 

Uncheck The print qualities of the Excel sheet are united in high quality 

and document is registered. to keep the printing quality. 
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10.4 Configuring Chat 

 
You can change the settings of "Font", "Display color of chat message" and 

"Background color of chat message display region" on the Chat tab of the Tool 

screen. 

 
10.4.1 Font 

You can change the font and size of chat messages displayed on the 

chat screen. 
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10.4.2 Display Color of Chat Message 

You can change the color of chat messages displayed on the chat 

screen. 
 

 
 

 

 To change the display color of messages you transmit: 

Select and set My display color to change the display color of your own 

messages. For whisper chat messages, the Whisper chat display color is 

used. 

 To change the display color of other participants' messages: 

Select and set Otherôs display color to change the display color of other 

participants' messages. 

 To change the display color of whisper chat messages: 

Select and set Whisper chat display color to change the display color of 

whisper chat messages. 
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10.4.3 Background Color of Chat Message Display Region 

You can change the background color of the chat character display 
area. 
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10.4.4 Header Display Style 

You can specify whether to insert a line break between the header 

(user name) and the message. 
 

 
 

 

 To remove the line break between the header (user name) and the message: 

Uncheck There is changing line to remove the line break between the user 

name and the message. 



 

 

 
 

10.4.5 Auto Save 

You can set whether to save chat messages automatically when a 
data meeting ends. 

 

 
 

 

 To save chat messages automatically when a data meeting ends: 

Check It  preserves it automatically and specify the destination to save them. 

The messages are saved automatically in the folder specified as the 

destination when a data meeting ends. 
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Chapter 8 - InMail Integration 
 

 

 
1 Introduction 

 
The UC Client, can integrate to the SV9100 InMail providing the user with a visual 

representation of their voicemail box and the ability to quickly manage this resource 

from their desktop. 

 A BE114063 SV9100 INMAIL INT-01 LIC (5312) license is needed for each UC Client 

that requires InMail Integration. 

 

SV9100 InMail integration supports the following functionality for each UC Client 
InMail user. 

 Message Status 

 View new messages 

 View archived messages 

 Message Access 

 Play new/archived messages through deskset terminal or Softphone 

 Set new message status to archive 

 Delete a message 

 Dial the number associated with the message 
 

 

2 Voicemail Features and Configuration 

 
2.1 Feature Activation 

 
The Voicemail feature is activated in Program 20-59-18. 

 
 The Integration with InMail option is not selected by default. 

 

 
 



 

 

 
 

2.2 Feature Configuration 

 
Each user can enable the voicemail integration feature by adjusting the 

settings within the Preferences menus. Refer to Preferences – Voice Mail 

Tab for the integration options available on the Voicemail tab. 
 

 
 

 

¿ Enable access to voicemail messages – controls if the user can display 
the voicemail message window. By default this option is not be selected. 

¿ Password required for voicemail login – indicates if the user voicemail 

account is setup to require a password for login. By default this option is not 

be selected. This field will only be enabled if the previous field has been 

selected. 

¿ Password – allows the user to enter their numeric password to login to the 

voicemail system. This field will only be enabled if the previous field has 

been selected. 
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3 Voicemail Message Display 
 

If the user has enabled the voicemail integration feature, the current set of voicemail 

messages can be displayed in a window similar to the Call Log window. This option is 

available when the UC Client UI mode is set to either Window or Toolbar mode. 

 
The Voicemail Message window can be accessed by selecting Voicemail from the 

Windows menu in Window mode. This option can be accessed in Toolbar mode from 

the File drop down Menu. When this option is selected, the voicemail message 

window is displayed 

 

 

 

 The voicemail message window shows the following information for each 

message in the user mailbox. 

 Date the message was received 

 Time the message was received 

 Caller ID – Number (if available) 

 Caller ID – Name (if available) 

 Duration of the message 

 Forwarding Extension (if applicable) 

 The Message counts at the top of the window indicate the number of New and 

Archived messages in the list. 

 All of the text for a New message is shown in Bold font. 

 All of the text for an Archived message is shown in Regular font. 
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 The user can re-sort the message list using the Date, Number, Name, Duration, and 

Forward fields. The default is to sort by Date, with the most recent message at 

the top. 

 The width of each field can be adjusted by the user. 

 The standard Window controls allow the user to Maximize, Minimize and Close 

the voicemail message list. 

 Pinning – to the far right side of the toolbar, there is a pushpin. Clicking this pins 

the Voicemail Messages widow to a tab in the BLF/DSS view. When pinned, if 

the Voicemail tab is active, the pin will UnPin the Voicemail from a tab and make 

it a separate window. 
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4 Voicemail Massage Operations 

 
4.1 Play, Archive, Delete or Dial Number 

 
A right mouse click on a New message will open a pop-up menu allowing the 

user to Play, Archive, Delete or Dial the message. VoiceMail Messages – 

Menu Screen provides an example of the operations available. 
 

 
 

¿ Play – initiates playback of the selected message through the supported 

telephone device (Softphone or deskset). 

 While Playback is in progress, no other voicemail functions can be initiated. 

¿ Archive – changes the status of the selected message from New to 

Archived. 

 Playing a New message does not automatically change the status to Archive. 

 A right mouse click on an Archived message displays only the Play and Delete 

functions. 
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¿ Delete – removes the selected message from the list and from the user 

voicemail box. 

¿ Dial – dial the extension or phone number associated with a message. 

 
4.2 Forward Message 

 
If a voicemail message has been forwarded to the user, the Forward column 

indicates the extension that forwarded the message. Hovering the mouse over 

the Forward cell in the message list opens a balloon displaying additional 

details of the forwarding party. 
 

 
 

The Forward balloon includes the following information (if available): 

¿ Name of Forwarding Party 

¿ Length of Introduction 

¿ Date Message was Forwarded 

¿ Time Message was Forwarded 

 
4.3 New Message Indication 

 
If the user has enabled the voicemail integration, a new message indication is 

displayed. The indicator shows the number of New messages in the user 

mailbox. Toolbar Mode shows the location of the indicator. 
 
 

 

 
Upon startup the desktop client checks the New message count. If the New 

message count is greater than zero, the message icon and message count is 

displayed. The message count is updated when the UC Client receives events 

that affect the new message count. If the new message count goes to zero, 

the message icon is removed. 
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Appendix  A - Features  
 

 

 
 

The following table shows a list of features that will be enabled for Softphone 
 
 

 

Feature 
 

Softphone 

IP Softphone * 

CTI Mode (Deskset)  

Dockable Tool Bar (Top, Bottom) * 

Full Screen Mode (Softphone has fixed 

window width with scroll bar) 

 

Phone Image/emulation * 

Auto Hide Toolbar * 

Pop-up on ringing call * 

Recently Dialed List in Toolbar * 

Speed Dial List * 

Function Toolbar * 

Configurable Functions, Order, and 

Shortcut Keys 

 

* 

Selectable Button Size (S/M/L)  

Call Status Area * 

Answer * 

Hold * 
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Feature (Continued) 
 

Softphone 

Transfer * 

HangUp * 

Dial * 

Conference * 

Page * 

Park * 

Unpark * 

Barge In * 

Directed Call Pickup * 

Last Number Redial * 

Voice Over * 

Forward Calls * 

Background Music * 

Auto-Callback * 

Do Not Disturb * 

Group Call Pickup * 

Pickup Other Group * 

Directed Call Pickup * 

Selectable Display Message * 

Record * 

Add/Edit Note in Call Log * 

E-Mail Integration * 

Ringing through Speakers * 

Confirm Dialog on Exit * 

Record Selective/All Calls * 

Personal Greeting  

Screen Pop (Outlook, Act! 2005+, 

Goldmine 6.7+, Time Matters) 1 

 

Screen Pop through SDK  

Outlook Selectable Contact Folder  

Pop when ringing/answered  



 

 

 

 
 

Feature (Continued) 
 

Softphone 

Pop on all calls/external only  

Outlook Add-in Screen pop  

Outlook Add-in Dial Out  

Print * 

Delete * 

Archive * 

Columns (In/out, Date, Time, Name, 

Number, Duration, User, Line, Note) 

 

* 

Sortable by Column * 

Recordings Attached * 

Playback of recordings * 

Auto Archive * 

Re-Dial * 

E-Mail * 

Edit Note * 

Local Company Directory * 

Access to Shared Directory  

Columns (BLF, Name, Number, Title, E- 

Mail, Location, Department, Super Name, 

Super Phone, Asst Name, Asst Phone, Alt 

Numbers, Notes) 

 
 

* 

One-touch transfer using Directory * 

Direct to VM using directory * 

Voice Over using directory  

Camp On using directory  

Name order in directory * 

Dial Extension * 

Dial Alternate * 

Voice Mail * 

Transfer * 



 

140  

 

 
 

 
 

Feature (Continued) 
 

Softphone 

Application Help * 

About (Version, License, Copyright) * 

License Activation * 

Trial Mode * 

Active ringing call list  

Top Most on Ringing Call  

Quick Transfer Voice Mail  

Quick Voicemail to an extension  

Call Redirect  

Able to send Phone Message  

Able to set/reset Night Mode  

Local One Touch Keys (108) (108 + 24 + 

8) 

 

System-Wide BLF  

BLF Icon (Idle, Ring, Active, DND, Fwd 

Immediate) 

 

Name  

Extension  

BLF Groups/Tabs (Order, Visibility)  

Configurable Text  

Configurable Order  

Open Video Window * 

Resize Video Window: Large/Small * 

Hide/Show Self-Image * 

Pause/Start Video Transmission * 

Four-Party Video Call * 

LCD Display * 

Softkeys * 

Line Keys * 

Function Buttons (Recall, Conf, Redial, 
Answer, Speaker, Feature, Mic, Directory, 
Message, Hold Transfer, Volume Up, 
Volume Down, Hookswitch) 

* 
 

* 
Dial Pad * 
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Feature (Continued) 
 

Softphone 

Message Waiting light * 

Naming of Line Keys - Abbreviated * 

Add-On Module * 

DSS Module * 

Separate Microphone and Speaker (Dual 

Audio) 

 

* 

Adjustable Ring Volume * 

USB Headset/Handset * 

Collaboration (Data Conference) * 



 

 

 

NEC reserves the right to change the specifications, functions, or features at any 

time without notice. 

 
NEC has prepared this document for use by its employees and customers. 

The information contained herein is the property of NEC and shall not be 

reproduced without prior written approval of NEC . 

 

Dterm, NEAX and UNIVERGE are registered trademarks of NEC Corporation. 

Windows is a registered trademark of Microsoft Corporation. AT&T is a registered 

trademark of AT&T Wireless Services, Inc. Pentium is a trademark or registered 
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